DCS data reduction and analysis

Getting started

For the DCS data reduction and analysis you will be using the program DAVE (Data
Analysis and Visualization environment). This software was developed at the NIST
Center for Neutron Research. Every effort has been made to ensure that DAVE is
supported under Linux, Windows, Mac-OS10 and SGI-Irix. It is available at no cost to
users. For detailed information about the program including how to download it, please
visit the official DAVE web site: http://www.ncnr.nist.gov/dave.

The aim of the experiment is to investigate the motion of the hydrogen atoms in
Mn[N(CN).]..pyrazine. In order to do this you must first reduce the data to obtain the
incoherent scattering function S, _(Q, ®) . You will then analyze the experimental
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S, (Q,m) by fitting it with appropriate combinations of mathematical functions

(Gaussians and Lorentzians). The Q dependence of the amplitudes and widths of these
functions can then be compared with predictions based on models representing different
types of motion.

Data reduction

Before the summer school we made a series of measurements that you will use to reduce
the data that you obtained using the protonated pyrazine compound. In what follows we
shall describe the reduction of datasets that we obtained earlier, using 5.7g of the
deuterated version of the compound.

The following table lists file names and temperatures for each of the data files that we
shall use in the data reduction.

File Name

T(K)

Deuterated sample

20030522_018.dcs.gz
20030523_003.dcs.gz
20030523_010.dcs.gz

390K
400K
300K

Vanadium

20030522_013.dcs.gz

Room temperature

Dark count
(Fast background)

20030515_001.dcs.gz
20030515_002.dcs.gz

(Room temperature)
(Room temperature)



http://www.ncnr.nist.gov/dave

| Double-click on the appropriate icon to start the runtime development version of
DAVE. The following screen will appear:

i] DAYE: Data Analysis and Yisualization Environment - running under IDLDE B |EI|£I

File | Daka Reduction  Visualization Data Analvsis  Tools  Misc
Reduce DCS raw data

FCS DiZ5 Mslice
HFES

TAS 7 2,
FarS ‘ "
ASCII data l d

F 3

Data Analysis and Visualization-Environment

"NIST Center for Neutron Research ‘

Click “Data Reduction=>DCS->Reduce DCS raw data”.

| Preliminaries

x

The raw data directory is G:A200303%
Change the raw data directon |

The warking directon iz C:AMHkA-TEMPY
Change the warking directary |

Enter the output file prefis | vI
Browse |

Help |

R eturn b main menu |

Proceed |




| The raw data directory is the directory where the raw data files are located. The
data for the present example are on the computer called “solo” (which should be mapped
to your PC), in the directory /home/dcs/data/200305/. If this is not the current raw data
directory, click “Change the raw data directory”.

Select raw data directory x|

Current:
{a:4200303

Directories:

£ Inma
£ Jose

O maranas
£ Sankar_Nair
£ Udavic
Drives:
| B g WS0lotDCS Data | Cancel |

Select the correct directory and hit “OK”.

4 You will also need to define the working directory, which is where the files
generated by the data reduction will be saved. Depending on the day, use one of the
following: “C:\SS03\MonTue”, “C:\SS03\TueWed”, or “C:\SS03\WedThu”.

4 You must provide an “output file prefix” for your data reduction. This prefix will
be common to all files generated during the data reduction session. For this example we
have chosen “deuterated” as the prefix and we have chosen to reduce data for the sample
at three different temperatures. This means that if we choose the symmetrized S(Q,®) as

final output the following list of files will be created in the working directory:

Intermediate | deuterated_samlsum.dave
files deuterated _sam2sum.dave
deuterated _sam3sum.dave
deuterated_bgdsum.dave
deuterated_vansum.dave
deuterated_samlcor.dave
deuterated_sam2cor.dave
deuterated_sam3cor.dave

Final reduced deuterated:sam 1SSQW.dave
files deuterated_sam2SSQW.dave
deuterated_sam3SSQW.dave




Enter the output file prefix in the box provided in the “Preliminaries” window, and then
hit “Proceed”.

4 Specifying the raw data input files

x|

“ou muzt first identify the fles that will be uzed in thiz
TEETION.
To gelect filez click "Select"’.
Torestore a previously zaved list of files click "Restare®'.
T o return to the main menu click 'Main menu'.

Select | Restare I ki air rmenu |

If this is the first time you are reducing the data files, you must click “Select”. If you are
redoing the data reduction and have previously saved the list of files (the file name will
be “deuterated.fls”) you can instead click “Restore”.

4 Choose the files for the sample. Click “Help”, or ask for help, if you have
problems using this widget.

x

|3 file[z] zelected for the Sample |

Curmrent drive: Current directony; Sub-directanes, it anw:

Y A [G:\200305 | [G:4200305\ nma-riming®

C:h : G:42003054 nmat,

D4 Go up one directony level | G:A2003054U davich

E::-:: T o to bop directany |evel |

[:h ¥

[2000 .[20030527
Start at Stop at Click to find files

[ 169 files found in this directary. |

[ ata files, if an: Selected files:
20030523_002. dcz.gz a | |GAN2003058420030522_018 dos.gz -
20030523_003.dez.ge G:200305420030523_003. des.gz [
20030523_004.dcz.gz G:4200305420030523_010.des.gz

20030523 005.desgz |
20030523_006. des. gz

20030523_007.des. gz
20030523_002.des. gz

Back DOME | ABORT

CLEAR | HELF

S|l v af 8] wee




To select the vanadium (background) files, click “V” (“B’) and then double-click on the
appropriate file names.

Once you are satisfied, click “DONE”. You will get the following type of screen.

X
These are the filez pou have zelected.
Sample files
G:4200305%20030522_018. dos.gz G:4200305%20030523_003 dos.gz

5:%2003054 20030523 010.dcs.gz

Yanadium files

;42003054 20030522 013.dos.gz

Background filez

G:4200305%20030515 001, dose.gz G:%200308%20030575 002 dos.gz

'ou may Revize your file zelection, 5 ave your selection, Proceed, or go to the main Menu.

Revize | Save | Froceed I ain Menu |

Check the names of the files and revise the selection if necessary. Once you are satisfied
you may wish to save the list of files (which can be very useful and time-saving). You
can then proceed to the next step in the data reduction. You may have to wait a short time
while various operations are performed on the raw datasets.

4 Multiple sample conditions

The DCS reduction software allows you to reduce multiple sample datasets in parallel
(multiple sample datasets meaning datasets obtained under different sample conditions),
as long as the same auxiliary datasets (empty container, vanadium, background, etc) are
used with all sample datasets.

x|

The nest ztep iz to have you label each zample file
accarding ta the conditians af the run. IF all zample files
comezpond ko a gingle sample condition click "Single’’.

|f there iz maore than one zample condition click "“Multiple',
To return to the main menu click “Main menu'.

Single " Multiplel kd ain memn |

In this example we are simultaneously reducing sample data at three different
temperatures, so we select “Multiple”.



x|
If sample conditions ard assighments have been saved ina
PrEvious
daba reduchon session and you wizh bo reslose this
irformation chck “Peston'.
Oitheriese ched "Defne’”.

Frestore [ Detire |

We rust now define the conditions to be associated with the different files. &lternatteely we
could restore this information if' it had been saved presiously. Presurrdng that this is not the
case, click “Define™

i Assign a conditbon to each data files x|

 [00E C 40000K O Z000E  GA20030S2003052Z MR dosg2

© H00OL & A0000K C MO000K  GAI00305WA0030523 003 dosge

T o28000K T ADOO0K  F ROQO0K  GOAZO0R0SE0020522 M0.dosge

Lo

The default assuraption is that the different sarnple conditions are distinguished by their
temperature set points. Since thiz i3 the case, click *“Done™.

] Deline Lhe condition{s) to be associated with data fHles ﬂ
Choubibs-click. on & cel o edit . Enba 3 sampls condition descriolion and then hit RETURM o save il
Hit the Done bigton when youte done:
If o conditions ane defined it wal be azsumed Bt ol sample ins can be added fogesher
Condlic |

1 .

2 400.00K. :l

3 300.00K -
Al 2

4
Dene | Clean |[3 conditions have been defined)

The table (showr above) relates each saraple data file to one of the saraple conditions.
Lgsurmng it 15 correct, chek “OF™



x|
These are the zample filez coresponding to each sample condition,
Conditior: 390,00k,
G:42003054%200230522_ 018 dos.gz
Conditior:, $00.00F,
3:52003054%20030523_003.dcs.gz
Condition:; 30000k,
G:52003054%20030523_010.dcs.gz
To revize conditionz click "Back'.
Otherwize click "Procesd",

Back | Froceed I

A list of sample conditions and associated files now appears. The first listed (n’th listed)
condition corresponds to output files with names containing the string “sam1” (“samn”)
(see above). Thus in this example the output files “deuterated_samlsum.dave”,
“deuterated_samlcor.dave” and “deuterated_sam1SSQW.dave” correspond to the 390K
data. It may be useful to record separately the order of the entries in this list.

If the list of conditions and files is correct, click “Proceed”.

The next window (not shown) affords you the opportunity to save the sample conditions
and assignments to a file. This can be useful if you expect to redo the data reduction.

4 Detector masking

The next window (not shown) asks you to decide whether or not you wish to define a
detector mask. Masked detectors are excluded from the data reduction. Since we wish to
omit detectors that contain Bragg peak intensity (and possibly other detectors), click on
“Generate/restore”. The following widget appears.

& Define 913-element mask. i x|
Help | Clear | R estore | Save | Plat =iz | PROCEED | kain menu
MaSk DETECTORS | | ]
IMMASE DETECTORS | | 913

This widget allows you to define detectors to be masked by typing their numbers
following the phrase “MASK DETECTORS”. A more practical approach is to plot
detector sums, i.e. sums over all time channels as a function of detector number for one
or more of the input raw data files, and then select the detectors to be masked using the



mouse. You may save the list of masked detectors in order to be able to restore the list in
future data reduction sessions. For general help click the “Help” button. To use the
graphical approach click “Plot sums” and then select one or more files. When the plot
appears you may wish to click the “Help” button for additional help. When you are
satisfied with the mask, and have possibly saved the list of masked detectors, click
“Proceed”.

At this stage any so-called “bitflips” are corrected, the detector mask is applied, the
counts in each time channel are divided by the time channel width, nominally identical
files (in this example files 20030515 001 and 20030515 _002) are summed, and the
results are saved to disk in the DAVE format (with names containing the string
“sum.dave”). Please be patient.

4 Dark count subtraction

x|

T o gkip the 'dark count’ ['fast backaground'] subtraction
click "Skip"".

T o compute bime-averaged dark counts click "Compute",
T o compute and zave time-averaged dark counts click
"Computezave".

T o reztore time-averaged dark counts click “"Restare!’,
To enter an overall average dark count rate click "Owverall',
T o return to the main menu click "Main menu'™,

Skip I Compuite I Compute/zave | Restore I Dverall | b ain met I

The next step is to decide whether or not to correct all datasets for the “dark count”
(beam closed) background, and if so how. Since we have dark count data files and we
wish to perform this correction, click “Compute”.

4 Detector efficiencies

2 | ] |

& 91 3-element detectar efficiency aray iz now defined.
The same array will be wzed for all runs.
To zet efficiencies to unity click "Unit",
To compute efficienciez click "Compute”.
To compute and save efficiencies click "Computedzave'’.
Torestore efficiencies click "Restore".
T o return to the main menu click ''tMain menu®,

nity | Compute | Compute/zave | Restore I b ain metL |

Similarly we must decide whether or not to correct for variations in detector efficiency,
and if so how. As we have a vanadium data file we click “Compute”.



4 Grouping detectors

The next window (not shown) asks whether you want to group the detectors. Since you

do, click “Grouping”. The following widget will appear.

&l Detector Grouping

[~ DONOT GROUP DETECTORS

¥ Combine negative and positive angle detectors

o

Combine lower, middle and upper barkz

Combine lower and upper banks only

{
i~ Do not combine detector banks
{

Combine into groupz with equal widthz in 2theta

¥ Combine into groups with equal widths in "9"

Minirurn "G" 0,542 A-1
M awimurm "3" 1.968 41

Inzident wavelength 6000 4
Miriram 2theta  -23.93 deq
Mawimum 2theta  139.99 deg

Step in2theta

Step in 0"

| 10.0

| 013

Azzign detectors to groups

1B groups

Save

Restore | Proceed

B ark.

]

s 8 o e Y O o S s 8 o e Y o e 8 o e o Y e o e Y O s Y s ] o e

Angle
-B.02
502
-5.51
551
-6.00
E.00
-E.49
.49
-6.92
£.98
FATF
-
-7.96
796
-8.45
8.45
-8.94
894
-9.43
943

||u||

-0.092

0.03z2

-0.101

0.1m

-0.110

0110

-0.119

0114

0127

0127

0136

0136

-0.145

0.145

-0.154

0.154

-0.163

0163

0172

0172

(R SR S R T L A O T TN ' T N R o R (U O U B

M2

B

x|

Group ﬂ

If you make any changes you will need to click “Assign detectors to groups” to

implement the changes. You may wish to save the grouping information for later use.
When you are satisfied with the detector grouping click “Proceed”.

[arauping of detectors will now be perfarmed, tagether with
detector efficiency corections and normalization ta the
fizzion chamber countz. To proceed click “Procesd".

To return bo the main menu click “tain menu’

X

To define ar redefine detectar arouping click "[Re]defing'’.

Proceed I [Reldefine I bl ain meru |

At this point you can redefine the grouping, proceed or return to the Main menu. If you
click “Proceed” the program will perform a number of operations on the data: beam




closed background subtraction, detector grouping, beam monitor normalization, detector
efficiency corrections, and corrections using empty can and cadmium runs (if supplied).
The results for each sample condition will be saved to disk in the DAVE format (with
names containing the string “cor.dave”). This may take some time.

4 Deciding the form of the output

x
" Save as "d2sigma/dOmegadt” Check the box below to comect for
= energy-dependent detector efficiency

5 "d2zigmad0 dEf*
S v Apply the caomection
i~ Save az "S[0.omegal’
; : 5 ample temperatures
(;" i 1 1%
Save az "Symmetrized 5[0 omega)’t lecied i pie
i~ Save az "Chi'l0.omega)" detailed balance factors]
" Save as "glomegal’ |Series1: jT = 390.00K,
: |Series2: [T = 400.00K
% Savein DAVE format
: : |Series3: [T =300.00K
" Save in Octave ascii format
~ Save in Octave binamy format Proceed I
[ Compress the output data? Bl I

The “save strategy” widget allows you to choose the form in which to save the reduced
data. In this example the “Symmetrized S(Q,omega)” format was chosen. Note the
checked box indicating that the data will be corrected for the energy dependence of the
detector efficiencies. When you click “Proceed” the necessary data conversions are
performed and the results are saved to disk in the DAVE format (with names containing
the appropriate string, in this case “SSQW.dave”).

x|

To proceed click "Proceed".
T return ta the main menu click "Main menu’’
To zave resultz in another form and/or format click 'S ave
again''.

F'ru:u:eeu:ll b ain merL | Save again |

When this dialog appears you may click “Save again” if you want to save the data in
another format, e.g. S(Q, ) itself. In that case you will be presented with the “Save

strategy” widget once again. If you click “Proceed” you will be asked whether or not to
delete certain files and you will then be returned to the Main menu.

At this point the data reduction is complete and data files containing the symmetrized
scattering function S(Q,®) are in your working directory.
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Rebinning the DAVE files

Before proceeding to the data analysis we need to rebin the S(Q,®) data files. We do this

for two reasons. First of all, we are interested in a very small range of energies either side
of the elastic line and there is no need to retain the complete energy range (which extends
to > 300 meV in neutron energy gain). The other reason has to do with the energy
channels being unequally spaced. This can make Fourier transforms more difficult, and
much slower, than if the energy channels have identical widths. Furthermore equal width

energy channels are necessary if you wish to include the instrumental resolution function
in the data analysis using the “PAN” utility (see below).

4 To rebin, click on Tools—>General Tools—>Data Tools—> Rebin dave data file(s)

B}l DAYE: Data Analysis and Yisualization Environment o ] 4|
File DataReduction Yisualization Data Analvsis | Tools  Misc

General Tools  » Data Taoals » Create a DAVE data summ
DCS Tools » Miscellaneous  » Examine a DAYE datafile
HFEBS Taols 4 View a DAVE datafile treal
TAS Tools 4 Save DAVE data in ascii fc
FAMS Toals — » Rebin DAVE data filafs)

A look at the current Davl

Data Analysis and Visualization-Environment

"NIST Center for Neutron Research Y

You will be asked to select the DAVE file(s) that you want to rebin. In this particular
example we have chosen the file “deuterated_sam3SSQW.dave”. First you are asked if

you wish to rebin in Energy transfer. Click “Yes”. Next you are asked if you wish to
rebin in Q. Click “No”.

21 As required, edit output channel specs and/or file name: x|

File C:\Mnmats'0RE S 52003 reduction03hdeuterated  deuterated_sam3550%W dave.
[rata from this file will be rebinned in Energy transter.

The 1000 input CHAMMELS range from -333.93 to 1.347102 mel

The |3DU output channels range from |-2.D to |1.341D2 e
Charrel width iz I 001112 mel.  Cancel | Proceed |

Outpuit file name
II:: Wamaw ORFEASS 2003 v reduction02hdeuterated v deuteratedsam3SSEW b, dave

4 You are now asked how you want to rebin the energy channels. It is generally a
good idea to have very roughly the same number of channels within the chosen energy
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range before and after rebinning. In this example we chose 300 output channels between
—-2.0 meV and 1.34102 meV, giving a channel width of 0.01112 meV. The default output
file name, displayed at the bottom of the window, may also be edited. Once you are
satisfied, click “Proceed” and the rebinned data file will be created.

Fitting model functions to the data

To determine the EISF we must determine the relative integrated intensities of the elastic
and quasielastic contributions to S(Q, ®) . To get these quantities we will use the program
PAN, which is part of DAVE. We will provide a detailed example that shows how to use

PAN to fit the DCS reduced data files. For more information about PAN the reader can
view the PAN manual at http://www.ncnr.nist.gov/dave.

L Start PAN by selecting Data Analysis = PAN (Peak Analysis)

£]/PaN: Peak Analysis

=1oix]
File Print Resolution Miscellaneous
Select Function Lookup tables laaded =]
1
4 B
Group selection
Modify fit parameters
et o
e
-
1
il 2
Curve selection
:
il _1“‘
Groups to fit

HTML Log Controls
Create new HTML log file

Open existing HTML log file

Fitting status
Fiesting

Display fit paramaters

Plot fit patameter

Plot EISF

Lag fie status

closed
Fiebin data

Log fil name
Flestore viginal data

4 To load the file to be analyzed, select File > Load DAVE file. The data will
appear in the upper window of the widget. By default you will see the first group. If you
want to see the other groups use the “Group selection” scroll bar.

4 To save information related to the current session you may wish to create an html
file by clicking “Create new HMTL log file” (at bottom right).

12
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Edit the entries and click “Accept”.

&l Directory name i x|

Directary name

deuterated_log

Ilzer name

DCS's gang

Lo file title

deuterated fit|

Accept 1 Cancel l

A new file called “index.htm!”” will be created in the newly created directory
“deuterated_log” (which is a subdirectory of your working directory). Once it has been
created you can click “Enter comment” in order to place some text in the file. You can
also click “Add plot to log” and the graph on the screen will be added to the log file.
Once you are finished with PAN, you should click “Close HTML log file” to close the
file. You can always reopen it if you wish, by clicking “Open existing HTML log file”

4 A reasonable model to fit the experimental data uses a Gaussian function to fit the
resolution-broadened elastic peak and a Lorentzian for the quasielastic scattering. To
create an initial Gaussian click “Select function” and then select “gaussian”. The text box
at top right will tell you what to do next; it will read as follows: “Hold left mouse button

down and drag function centroid”. In this way you can vary both the centroid and the
amplitude of the Gaussian.

& PAN: Peak Analysis o =] 54
File Print Resolution Miscellaneous

Select function

Hold left mouse button down __j
and drag to change width

3
EIf| 2|
Graup selection
Modity fit parameters

Clear cunent curves

Clear all curves

Femove selected cunve

1

Kill| |

Curve selection

Fit current group

Fit all groups

|rterrupt fit _<_] Lr—i
HTML Log Controls
Create new HTML log file

Groups to fit

1-14

Fitting status

Open existing HTML lag file
Fiesting

Display fit parameters

Plot fit parameter

Plot EISF Log file status:

closed
Febin data

————— Log file name
Restore oniginal data
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When you release the left mouse button, the following message will appear: “Hold left
mouse button down and drag to change width”.

&l |PaN: Peak Analysis =10
File Print Resolution Miscellaneous
Select function ! _1

3
ET T |
Group zelection
Modify fit parameters

Clear curment clrves

Clear all curves

Remove selected curve

I

Curve selection

Fit current group

Fit all groups ;
|terrupt fit K| ‘,_r'J
Groups ta fit HTML Log Controls
114 Create new HTML log file
Fitting status ) Energy trans Open existing HTHL log file
Fiesting I

Dizplay fit parameters

Plat fit parameter

Plat EISF Log file status:

= cloged
Febin data -
Log file name

Festare onginal data

This time, on releasing the button, a Gaussian based on your choices of centroid,
amplitude and width is displayed as a solid line. You can use the same procedure to add a
Lorentzian function. If you want the residuals to be plotted click the left mouse button
after defining the functions.

As a general rule, click the right mouse button to autoscale any plot.
Before attempting to fit this group you should constrain the fit by forcing the centers of

the Gaussian and the Lorentzian to be the same. To apply constraints, or to change the
values of the parameters, click “Modify fit parameters”.

x4
GAUSSIAN
Values Fixed Set Low Lower Limit Set High Upper Limit Tie
area|0.BETATE [ ey I~ aea area|0.000000 W = area|0.000000 B s
center|-0.0237484 I center [ center center]D.DDDDDD [~ center center|0.000000 V¥ center
FwHM([007a0804 | T FwHM T FwHM  pwHm[0.000000 ™ PwHM  Fyyhi [0.000000 ™ Fw/HM
ﬁppl_l,l] Dizmizs
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Displayed is parameter information for the first curve that you chose to fit the data. By
default there are no conditions on the refinement, so you should check appropriate boxes,
enter values as needed, and then click “Apply”. In the present example we wish to “tie”
the centers of the Gaussian and Lorentzian curves. To do so we must check the “Tie
center” boxes for both curves. Finally click the “Dismiss” button.

4 Click “Fit the current group”

&l PAN: Peak Analysis =lol=x
File Print Resolution Miscellaneous
Selectfunction | | i el N |~~~ """~~~ .'_j
Curve 1: SALSSTAN
#0: areq: 4.664e-001 +'- 247 22-003
3 #1: center: -1.210e-002 +/- 8.667¢-005
_‘J _.I _'_I #2: PAHA: 5.935e-002 +/- 2.366e-004
Group selection | e | |
Modity fit parameters Curve 2: LORENTZIAR
#3: area: 3.145e-001 +/- 2.2952-003
Clear cunent curves #4: center:-1.210e-002 +/- 0.000e+000
#5: PWHM: 2.1242-001 +/- 2.5902-003
Clear all curves
Femove selected curve Chi-squared: 15.100
1
Eil[| |
Curve selection
Fit current group
Fit all groups i
| rterrunt fil _e_] ;rj
Groups to fit HTML Log Controls
1-14 Create new HTML log file
Fitting status Open existing HTML lag file
Resting E
Display fit parameters
Plot fit parameter fefs:
Plot EISF Log file status:
closed
Rebin data -
Log file name
Restore onginal data

In order to evaluate the fit you should examine the residuals in the lower plot window and
the fitted parameters in the upper right text area. Looking at the residuals in the present
example you will see that there are two problems. First, there is an overall offset in the y
direction. Second, the experimental data are not fully described by the combination of a
Gaussian and Lorentzian. The first problem should be resolved by adding a background
to the fit. Click “Select function”, select “background” and follow the instructions to
characterize the function. It is good practice to start with the background flat (i.e. zero
slope). Click “Modify fit parameters”, select “BACKGROUND?”, and check the “Fixed”
box for the slope (whose default value is 0.0).

x
[3ACKGROUND =]
BACKGROUND
Yaluesz Fined Set Low Lowwer Limit — Set High Idpper Limit Tie
offset|0.0B3631522 ™ gfset I affset  offsetj0.000000 I offset  offset|{0.000000 I offset

slnpelD.D v slope [~ slope slope]D.UDDDDD [ slope sInpe‘D.DDDDDD [~ slope

Dizrnizs
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Click “Fit current group” again and see the improvement.

&l PAN: Peak Analysis _iolx
Filz Print Resolution  Miscellaneous

Select function ! mean QLA =U0.405822 [ J
Curve 1: GALISSTAMN

#0: area: 4.282e-001 +/- 4 071e-003
#1: center: -1.209-002 +/- 8.732e-005
#2: PA/HM: 5 752e-002 +/- 2.961e-004
curve 2: LORENTZIAMN

#3area: 3.1852-001 +/- 3.74%-003
#4: center: -1.2092-002 +/- 0.000=+000
#5: PAYHM: 1.498e-001 +/- 3.002e-003
Curve 3: BACKSROUMD

#6offset: 1.417e-002 +- 2.4182-004
#7: slope: 0.000e+000 +/- 0.000+000

C o

Group selection
Modity fit parameters

Clear current curves

Clear all curves

Remove selected curve

T

Curve selection chi-squared: 6 22T

Fit all groups :
Irterrupt fit Aﬁj .’H
Groups tofit HTHML Log Controks
1-14 Create new HTML log fil
Fitting status Open existing HTML lag file
Resting

Display fit parameters

Plaot fit parameter

Plat EISF

Log file status:
closed

Rebin data -
Lag file name

Residusls

Festare ariginal data

Energy tran

Given the fit parameters and the residuals, it is necessary to decide whether or not the fit
is acceptable. There is no general formula for this decision. In the present case, given that
we have not taken into account the instrumental resolution function, we can reasonably
argue that the fit is acceptable.

L Once we’re happy with the fit to a single group, we can click the button “Fit all
groups”. Fitting will occur for all of the groups specified in the box labeled “Groups to
fit”. You can change the groups to be fitted. This is sometimes imperative, e.g. if the
detector mask was defined such that one or more of the groups contains no data, in which
case PAN cannot fit these groups. In this case the “Fitting status” box will read “Fit
cancelled”.

Having clicked “Fit all groups” you can watch as the program fits the selected groups
using the chosen model including constraints. At this stage you should check the fits to
make sure that everything is OK.

4 You can save the fitted data by clicking “File - Save fit parameters as text”. A
text file will be created with the fit information. The following screen shot shows an
example of such a file.
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B deuterated.fit - WordPad =

File Edit WYiew Insert Format Help

=lolx]

Dl || Sl al &=
A .1 EOW L RO §

2 S S 3 K ! L o)

L -

F

Group: 1

Curve 1: GAUSSIAN

#0: ares: 1.490e+000 +/- 3.586e-002

#1: center: -1.184e2-002 +/- 5.827=-004

#z2: FWHM: 5.748e-002 +/- 1.282e-003

Curve 2Z: LORENTIIAW

#3: area: 2.706e+000 +/- 6.514e-002

#4: center: -1.154e-002 +/- 0.000e+000

#5: FWHM: 5.820e-001 +/- 2.379e-002

cCurve 3: BACEGROUND

#6: offset: 1.951e-002 +/- 1.14Ze-002

#7: slope: 0.000e+000 +/- 0.000e+000

Chi-squared: 0.875

Group: 2

Curve 1: GAUSSTAN

HOe mvmeme £ &2~ NOA (3 A ANSe- Pna — .:J
For Help, press Fl | MU

Note that this file does not contain information about the constraints that you imposed.

L A very useful tool within PAN allows you to plot the fit parameters as functions

of Q and to save them in three-column text files. Click the button “Plot fit parameter”

and the following screen will appear.

l:]_Parameter plotting utility

Parameter # i'l Aeocept |

=10 ]

Savel F'rintl JPEG I Add plotta

file: | Dismiss l
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You can now examine any fitting parameter by entering its number. If you do not
remember which is which, take a look at the text box on the right hand side of the main

PAN widget.

&l Parameter plotting utility N —10] =|

Farameter tt;D

Save | Piint | JPEG | A plot to o e || Dismiss |

In this example parameter #0 is the area of the Gaussian. For the first group, and perhaps
the second group also, the parameter does not behave as expected. It is quite often the
case that DCS data at low angles is problematic, so it is prudent to ignore these groups.

The example below (using different input data) illustrates a situation where a single
group is clearly suspect, suggesting that something went wrong during data reduction.

&j Parameter plotting utility N =13l x|

Parameter ﬂ;[l :

Save ] Frint I JPEG | Add plot ta log file | Dismizs I
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These examples are intended to show that there is no way to do the data analysis without
a certain amount of critical human intervention. It is important to check each fit, having
in mind some idea of the expected behavior of the various fit parameters.

| Within the application “Plot fit parameter” clicking “Save” will create a three-
column text file containing Q, Parameter(Q), Error_Parameter(Q). An example follows.

_loix
File Edit Format Help

# mean QUI31salriule ®%12INIE-1IN] GAUSSIAM: area Error ‘:J
0.1158550 1.4595157 0.035855972
0.235735 0.626155958 0.0040079714
0.37521%8 0.42821930 0.0040711554
0.51312& 0.37128243 0.0038005922
O.&674525 0.2593254%9 0.0045857 0955
0.523851 0.32705357 O.00&09005%22
0.9753E57 0.32652417 0.0050451156
1.1z28585 0.22154995 0.00707&1345
1.278520 0.302390061 0.0044743913
1.428587 0.281581024 0.00457912965
1.57799 O.31425272 0.0038504216
1.7281z2 0.22458793 0.002525310s8
1.87367 0.41534459 O0.00z20040440
1.95852 0.73104868 0.0045359324

=

Kl H 4

Getting the EISF from the fit

Given the fits to the protonated and deuterated samples, we wish to obtain an
experimental EISF. One possibility is to use the following expression:

G
EISF = d
G,+L, -w-L,

where Gpand L, are the areas of the Gaussian and Lorentzian functions that fit the
protonated sample scattering function, Lq is the corresponding area of the Lorentzian
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function for the deuterated sample, and w =m_ /m;, mp and mq being the masses of the

protonated and deuterated samples respectively.

Since there are relatively few groups, you can do this type of calculation using Excel,
paper and pencil, or whatever method takes your fancy. The following table shows an
example calculation.

Protonated Deuterated
410K 400K
Q Gp eGp Lp eLp Ld eLd E I SF
0.119| 1.283| 0.030| 2.826| 0.061/ 2.711| 0.064] 0.535|
0.236| 1.617| 0.005| 0.453| 0.004] 0.386) 0.004] 0.886|
0.376 1.806| 0.003| 0.477| 0.003| 0.316| 0.003| 0.867|
0.513| 1.535| 0.004| 0.565 0.003| 0.313| 0.003| 0.807|
0.675| 1.345| 0.005| 0.678| 0.004] 0.296| 0.004| 0.733|
0.824] 1.190| 0.005| 0.758| 0.005| 0.298| 0.004] 0.676|
0.976| 1.041] 0.005| 0.806| 0.005| 0.295| 0.003| 0.627|
1.129| 0.930| 0.009| 0.805| 0.008| 0.291/ 0.005| 0.600|
1.279| 0.851| 0.005 0.758| 0.005] 0.301] 0.003| 0.600|
1.429| 0.836| 0.005, 0.696 0.005] 0.295 0.004| 0.621|
1.578| 0.836| 0.004| 0.594] 0.004] 0.270| 0.003| 0.664]
1.728| 0.832] 0.003| 0.543| 0.003| 0.263| 0.002| 0.688|
1.880| 0.760| 0.003| 0.471| 0.002| 0.268| 0.002| 0.716|
1.959)| 0.841/ 0.006| 0.464] 0.005| 0.254] 0.004] 0.735|

EISF=Gp/(Gp+Lp-w*L_d)

|

| w=m_h/m_p=3.6/5.7

Note that errors are not calculated.

4 Once you have generated your experimental EISF, you can create a three-column
text file and then use PAN to fit the EISF to a model such as one of the models described
in the Summer School handout. Here is an example of an experimental EISF text file,

called “410K-EISF.txt™:
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-lo x|

File Edit Format Help

# mean QU131sAlriUle %13 IN1E-11K] LORENTZIAN: area Error ,.:J
0.276z18 0.3812186257 0.00%
0.513126 0.858558055  0.005
0.&6746285 0.778845153 0.00%
0.822851 0,720725567 0,008
0.376257 0.670722387 0.008
1.12889 0.643845986 0.008
1.2783 N.653886362 0.008
1.42887 0.680011161 0.008
1.57799 0.718775341  0.005
1.72812 0.7478632048 0.00%
1.87967 0.790612514  0.005
1.95852 0.80042143¢ 0. o0s|

""j i

L You can load this type of file within PAN, selecting “File > ASCII files > Load
three col ascii data”.

&) PAN: Peak Analysis 10l x

File Print  Resolution  Miscellaneous

Select function !

4

Mo curves selected __j

Madity fit parameters

Clear curent curves

Clear all curves

Remove selected curve

T

Curve selection

Fit cumrent group
Fit all groups

Ly o

Groups to fit HTHL Log Controls
141 Create new HTML log fil
Fitting status Open existing HTML log file

Fiesting

Plot fit parameter

Plat EISF Log file status:

= closed
Rebin data -
Lag file name
Restore ariginal data

4 To fit the EISF you have to define a user function. Click the “Select function “
button and select “userfunction”.
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x
e.q. p[O]+p[1]*x+p[2]*x"2
pLOI+p[1]"x+p[2]*x"2

Save Exprezsion | Restore Expresszion | Aocept I Cancel |

The default expression, shown above, should be replaced with something more
appropriate. As an example, the user function for a model where a proton is jumping
among three equivalent sites equally spaced on a circle is as follows:

0.333333*(1+2*sin(p[1]*x)/(p[1]*X))

where p[1] is the parameter r, which is the distance between any two sites.

x|
e.q. p[O]+p[1]*x+p[2]*x"2
0.333333%(1+2%sin(p[ 1]")/ ([ 1))

Save Exprezsion | Restore Expression | Aocept | Cancel |

Note that you can save the expression and later restore it.

Now that your function is defined, the refinement may be performed in the same fashion
as before. With luck you will be able to interpret the values of the fit parameters in terms

of the model.
Good luck!
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